
LESSON 9 Margins and Print Options WD-1

True/False Questions
Each of the following statements is either true or false. Indicate your 
choice by circling T or F.

Concepts Review

T    F  1. Word has default settings for margins that are automatically set for 
each new document.

 2. You can change margins in Print Layout view by using the ruler.

 3. You can edit a document in Print Preview.

 4. Both Print Preview and the Page Setup dialog box use horizontal and 
vertical rulers to drag margins to desired positions.

 5. You can change margins for an entire document only by using the Page 
Setup dialog box.

 6. Gutter margins are outside margins on a bound document.

 7. The Shrink One Page feature reduces the size of the document by one 
page.

 8. Landscape is the default page orientation.

Short Answer Questions
Write the correct answer in the space provided.

 1. What is the default document view?

 2. What does the pointer look like when it is located over the margin 
boundary on the ruler in Print Layout view?

 3. What is created when you change margins for selected text?

 4. Which kind of document needs gutter margins?

 5. Which tab, in which dialog box, do you use to change page orientation?
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UNIT 3 Page FormattingWD-2

 6. How do you switch to Edit mode in Print Preview?

 7. Which key to you press to show the exact margin and text area 
measurements when using the ruler to change margins?

 8. What is the term for pages that appear as a two-page spread with odd-
numbered right pages and even-numbered left pages?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

 1. Collect samples of printed documents with interesting treatments of 
margins (such as books, advertisements, or reports). Pay particular 
attention to mirror margins and gutter margins. How does the margin 
treatment contribute to the overall feeling of the document?

 2. Use Microsoft Office Word Help ( ) or practice on your own to explore 
the Book fold feature that is located in the Page Setup dialog box, 
Multiple Pages section. What type of document would you create to use 
this feature? Is the feature helpful?

Skills Review

Exercise 9-14
Set margins for an entire document and for selected text by using the Page 
Setup dialog box.

 1. Open the file Gresh.

 2. Change the margins for the entire document by following these steps:

a. Click the Page Layout tab, and click the Margins button .

b.  Click Custom Margins, and set the Top margin to 2 inches, the 
Bottom margin to .75 inch, and the Left and Right margins to 
1.25 inches. Click OK.

 3. Change the margins, and create a new section for selected text by 
following these steps:

a.  Select the text that begins “Campbell’s Confections.” through “Fax: 
304-555-6660.”
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WD-3LESSON 9 Margins and Print Options

b. Open the Page Setup dialog box.

c. Set the left and right margins to 2 inches.

d.  Choose Selected text from the Apply to drop-down list, and click OK. 
The address appears by itself on a new page.

 4. Click the Undo button  to undo the new section.

 5. Key the text Matthew Garrett, Manager as a separate line before 
“Campbell’s Confections” in the body of the letter.

 6. Save the document as [your initials]9-14 in your Lesson 9 folder.

 7. Submit and close the document.

Exercise 9-15
Set margins in Print Layout view and Print Preview and change 
orientation.

 1. Open the file Chocolate.

 2. Change the left and right margins in Print Layout view by following 
these steps:

a.  Click the Print Layout View button  located on the right of the 
status bar.

b.  If the rulers are not displayed, click the View Ruler button .

c.  Using the horizontal ruler, position the pointer on the left margin 
boundary until it becomes a two-pointed horizontal arrow (and the 
ScreenTip “Left Margin” appears).

d.  Hold down  and drag the margin boundary until the left margin 
measures 1.5 inches.

e.  Position the pointer on the right margin boundary and use the same 
method to drag it to 1.5 inches.

 3. Change the top margin in Print Preview by following these steps:

a.  Click the Microsoft Office Button. Click the arrow beside Print, and 
click Print Preview.

b.  If the rulers are not displayed, click to select the Show Ruler 
command.

c.  Using the vertical ruler, position the pointer on the top margin 
boundary until it becomes a two-pointed arrow.

d. Hold down  and drag the top margin boundary to 2 inches.

e.  Click the Close Print Preview button  to return to Print Layout 
view. Drag the Zoom control to 100% if necessary.

 4. Add a bold, centered, and uppercase title TYPES OF CHOCOLATE to the 
top of the document, with 24 points spacing after.

 5. Change the orientation to landscape by following these steps:

a. Open the Page Setup dialog box.

b. Click the Margins tab and choose Landscape.
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UNIT 3 Page FormattingWD-4

c.  Change the top margin to 2 inches, change the bottom margin to 
1 inch, and change the left and right margins to 1.25 inches.

d. Click OK to close the Page Setup dialog box.

 6. Save the document as [your initials]9-15 in your Lesson 9 folder.

 7. Submit and close the document.

Exercise 9-16
Set mirror and gutter margins.

 1. Open the file Corporate Gifts - 2.

 2. Use the Page Setup dialog box to set mirror and gutter margins by 
following these steps:

a. Open the Page Setup dialog box.

b. Choose Mirror margins from the Multiple pages drop-down list.

c. Change the inside and outside margins to 1.5 inches.

d. Set the Gutter margin to .5 inch.

e. Click OK.

 3. Scroll through the document in Print Layout view to see the new 
margin settings.

 4. Switch to Print Preview.

 5. Click the Two Pages button , to see both pages display with the 
new margin settings. Click the Close Print Preview button .

 6. Save the document as [your initials]9-16 in your Lesson 9 folder.

 7. Print the document two pages per sheet, by following these steps:

a. Click the Microsoft Office Button.

b. Click Print to open the Print dialog box.

c.  Click the drop-down arrow beside the Pages per sheet option and 
choose 2 pages.

d. Click OK.

 8. Submit and close the document.

Exercise 9-17
Set print options, print an envelope, and print labels.

 1. Open the file WV Stores.

 2. Print a portion of the document by following these steps:

a.  Select the text for the “Wheeling, WV” store—from “Campbell’s 
Confections” through the fax number.

b. Press �  to open the Print dialog box.

c. Choose Selection and click OK.
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 3. Insert the date by following these steps:

a.  Go to the end of the document, and press  four times. Key the 
text Updated and press .

b. Click the Insert tab, and click Date and Time.

c.  Choose the fourth date format, make sure Update automatically is not 
checked, and click OK.

d. Insert a blank line after the date.

 4.  Prepare an envelope addressed to the Morgantown 
store by following these steps:

a.  Select the name and address lines for the Morgantown 
store. Do not select the telephone and fax numbers.

b.  Click the Mailings tab. Click the Envelopes button. 
Click the Envelopes tab.

c.  In the Delivery address box, delete the comma in the 
address, and key -3301 at the end of the ZIP Code.

d.  In the Return address box, key your name, followed 
by the office address:

 Campbell’s Confections

 25 Main Street

 Grove City, PA 16127

 5. Choose additional envelope options, and add the envelope to the 
document by following these steps:

a.  Click the Options button and choose the Envelope Options tab, if it is 
not already displayed.

b. Make sure the envelope size is 10.

c.  Click the Font button  for the Delivery Address. Change the 
format to bold and all caps and click OK.

d.  Click OK in the Envelope Options dialog box. Click Add to Document 
in the Envelopes and Labels dialog box. Do not save the return 
address as the default.

 6. Prepare the printer for a standard business envelope (or feed a blank 
sheet of paper into the printer). Print the document (envelope included).

 7. Save the document as [your initials]9-17a in your Lesson 9 folder.

 8. Create and print a page of return address labels by following these steps:

a.  With the insertion point in section 1 (the envelope), open the 
Envelopes and Labels dialog box and click the Labels tab.

b.  Check the Use return address box. (Word recognizes the return 
address you previously entered for the envelope.)

c.  Choose the option Full page of the same label.

d.  Click Options. Set the Product number to 5160 and verify that Page 
Printer and Avery US Letter are selected. Click OK.

e.  Click New Document to save the labels as a separate document. Do 
not save the return address as the default.

f. Save the labels as [your initials]9-17b in your Lesson 9 folder.

g. Print the labels on a blank sheet of paper.

 9. Close both documents.

TIP

Because this document contains many 
addresses, you need to select the text 

you want to appear in the Delivery 
address box of the Envelopes and Labels 

dialog box.
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Exercise 9-18
Set margins for a document and for selected text.

 1. Open the file PA Stores.

 2. At the beginning of the document, key the text shown in Figure 9-17, 
including the corrections. Use single spacing, and insert one blank line 
between paragraphs.

Lesson Applications

Figure 9-17

 3. At the top of the document, key the title Pennsylvania Stores in 14-point 
bold small caps as a separate line. Center the title, and add 24 points 
spacing after. Copy the title, and paste it to the left of the first store.

 4. Using the Page Setup dialog box, set the top margin to 2 inches and the 
left and right margins to 1.25 inches.

 5. Select the text beginning with the second title “Pennsylvania Stores” 
through the end of the document. Use the Page Setup dialog box to 
change the left and right margins for only the selected text to 3 inches.

 6. Change the top margin of the new section to 1.5 inches.

Than you for chosing Campbell’s Confectoins to provide your company  

with our boxed chocolates. We began as small down town office over 50 

yeaars ago. Today we have offices in three states and we provide quality 

chocolates to all our customers.

All of our stores work together ot meet all of your group or individual 

needs. We offer our products in the following areas:

Retail

Wholesale

Fundraising

For your convenience, Campbell’s Confections offers complete service  

from any one of our Pennsylvania locations. Our storelocations and phone 

numbers are listed on the following page. ^
tele

create as one paragraph using line breaks.

,̂

^
^
s

k

^
o

^ a

^
store

stores
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WD-7LESSON 9 Margins and Print Options

 7. Format all occurrences of “Campbell’s Confections” in the second 
section as bold italic.

 8. Save the document as [your initials]9-18 in your Lesson 9 folder.

 9. Print the document using the 2 Pages per sheet option in the Print 
dialog box. Close the document.

Exercise 9-19
Set margins for a document and for selected text, change page orientation, 
and set print options.

 1. Open the file Memo - 3.

 2. Insert today’s date in the date line.

 3. In the opening paragraph of the memo, replace the text “items below” 
with following information.

 4. Change the top margin to 2 inches and the left and right margins to 
1.25 inches.

 5. Select the text from “Beginning next quarter” through the end of the 
document. Change the orientation to landscape.

 6. Format the new section as follows: change the top margin to 1.5 inches, 
change the bottom margin to 1 inch, and change the left and right 
margins to 1 inch.

 7. Place a blank line above “Description/Model number.” Delete the 
paragraph mark after “Model Number,” and insert a tab character. 
Delete the paragraph mark after “Serial Number,” and insert a 
tab character. Continue this procedure until the line includes all 
items. Adjust the tab settings to distribute the text evenly between 
the margins. Change the font of the headings to Arial Narrow, and 
apply bold and small caps formatting. Apply a bottom border to the 
headings.

 8. Save the document as [your initials]9-19 in your Lesson 9 folder.

 9. Print the document two pages per sheet. Close the document.

Exercise 9-20
Set margins, set mirror and gutter margins, and address an envelope.

 1. Open the file Orders.

 2. Change the left and right margins to 1.25 inches.
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 3. Set mirror margins and a .5-inch gutter margin.

 4. Format the title as 14-point bold with a shadow effect. Add 72 points of 
paragraph spacing before the title.

 5. Justify all text below the title except the tabbed information.

 6. Go to the end of the document, and key a colon after “at” in the last 
sentence. Place each line of the company address on a separate line, 
and delete the commas after “Confections” and “Street” and the period 
after the ZIP Code. Format the address with 1.5-inch left and right 
indents, a 1-point box border, and gray shading.

 7. Add an envelope to the document, using the company address. Use your 
name and address as the return address. Do not save the return address.

 8. Select the paragraph headings beginning with “Online” through 
“Customer Service,” and change the font size to 12 points. Do not 
change the font size for the paragraphs beginning with “Note.”

 9. Save the document as [your initials]9-20 in your Lesson 9 folder.

 10. Submit and close the document.

Exercise 9-21  Challenge Yourself
Create labels.

 1. Open the file Haas.

 2. Format the document as a standard business letter. (Refer to Appendix B, 
“Standard Forms for Business Documents,” online at www.mhhe.com/
pas07brief for margin and spacing requirements.) Enter the date as 
a field. The letter is from you with the title Sales Associate and to the 
following person:

  Mr. Mark Haas

  215 Lake Street

  Girard, PA 16417

 3. Key the text shown in Figure 9-18 as the closing paragraphs.

Figure 9-18 Call our corporate gift specialists for assistance in 
selecting your customized gifts, maintaining your mailing 
list, and for information on volume discounts. The enclosed 
brochure explains the procedure for ordering.

We look forward to doing business with you.
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In these exercises you work on your own, as you would in a real-life 
business environment. Use the skills you’ve learned to accomplish the 
task—and be creative.

Exercise 9-22
Write a summary about a book you have recently read. Change the 
margins for the document, and change the margins of one of the sections 
of the summary that you want to highlight. Save the document as 
[your initials]9-22 and submit it.

Exercise 9-23
Create a document, and use the Page Layout tab to create a custom paper 
size. Change the width to 5 inches and the height to 3 inches. Change 
all margins to .4 inch, and change the orientation to landscape. Key a 
favorite recipe and format the text attractively. Save the document as 
[your initials]9-23 and submit it.

On Your Own

 4. Add an enclosure notation to the letter.

 5. Switch to Print Preview for a final view of the document.

 6. Save the document as [your initials]9-21a in your Lesson 9 folder.

 7. Create a sheet of labels (Avery Standard 5160) of Mr. Haas’s address as a 
new document. Use all caps and no punctuation in the address.

 8. Save the labels as [your initials]9-21b in your Lesson 9 folder.

 9. Submit both documents and close them.
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Exercise 9-24
Log onto the Internet, and find five Web sites about today’s current 
political topic. Create a document summarizing the topic with a pro and 
con approach. Format the document using landscape orientation. Save the 
document as [your initials]9-24 and submit it.
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